
Reports - running and scheduling reports

This chapter explains how to run and schedule reports available in ROSS. 
Topics in this chapter include:

• Getting started
• Working with Standard reports
• Working with User Community reports
• Scheduling a Report View
• Saving a report to your personal computer
• Using Citrix to access ROSS.

To access ROSS Reports

• On the Administration menu, click Reports.

IBM Cognos Connection screen - Public Folders tab

Getting started
This section provides an overview of Cognos terminology and toolbars. It also 
explains how to set up and organize your personal computer for ROSS 
Reports and Cognos. Topics include:

• Logging off of Cognos
• Understanding Cognos toolbars
• Setting up your personal computer for Cognos
• Organizing your reports.

Logging off Cognos
To prevent unauthorized persons working in your Cognos profile you must 
close your Cognos Internet Explorer session when finished with Reports. This 
is basic security protocol similar to logging out of ROSS and prevents 
unauthorized use of your ROSS profile.
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To log off Cognos and return to ROSS

• On the IBM Cognos Connection toolbar, click the Log On drop-down 
arrow, and then click Log Off.

The following diagram shows the IBM Cognos Connection toolbar. The 
arrow points to the Log Off link.

Understanding Cognos toolbars
The appearance of a Cognos toolbar is dependent on where you are in your 
report creation process. There are two distinct toolbars that may display on 
your screen for Standard and User Community Reports, including:

• IBM Cognos Connection toolbar
• Cognos Viewer toolbar.

Working with the IBM Cognos Connection toolbar

After selecting Reports from the Administration menu, your browser opens a 
new window and displays the IBM Cognos Connection toolbar. The buttons 
and drop-down arrows function in the same way as in other web-based 
applications. 

If you are unable to access Cognos after selecting Reports from the 
Administration menu, contact your System Administrator. You may need to 
add the Cognos site to your “Trusted Sites” on your Internet browser. For 
more information refer to the quick reference card, “Adding Cognos to Your 
Trusted Sites.”
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The following diagram shows some of the common elements and terminology 
on the IBM Cognos Connection toolbar as displayed User Community 
reports.

To refresh your report listing

• On the IBM Cognos Connection toolbar, click the Refresh button.

To change the view of your current session

To change the default view for all your Cognos sessions see, “Changing your 
default view preference,” in the section, “Setting up your personal computer 
for Cognos,” later in this guide.

1 On the IBM Cognos Connection toolbar, click the List View button to 
view the Standard reports as a list.

2 To view the details of the Standard reports, click the Details View button.
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Working with the Cognos Viewer toolbar

The Cognos Viewer toolbar groups the following similar functions into 
drop-down menus. The following diagram outlines the functions available 
from these drop-down arrows.

Setting up your personal computer for Cognos
This section outlines some common tasks to perform before running ROSS 
Reports and Cognos for the first time. Tasks include:

• To change your default time zone preference
• To enable all downloads for your Internet Explorer browser
• To download Acrobat Reader X.

You can also change the view for your current Cognos session by clicking the 
List View button or the Details View button, which are located on the IBM 
Cognos Connection toolbar.

To change your default time zone preference

The time zone you select determines when scheduled reports will run. Be 
sure you specify the correct time zone for your area and for your needs!

1 On the IBM Cognos Connection toolbar, click the My Area drop-down 
arrow, and then click My Preferences.

2 Under Time zone, click to select Use the following time zone.

3 Click the Time zone drop-down arrow, and then click to select the time 
zone of your choice.

4 Click OK.
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The following diagram shows the lower portion of the Set preferences screen. 
The arrow points to the Time zone field.

To enable all downloads for your Internet Explorer browser

If you choose to save your reports in Excel 2000 single sheet or Excel 2002, 
you must enable all “Downloads” on your Internet Explorer browser. You may 
need Administrator access to perform this task!

1 Start your Internet browser.

2 On the Tools menu, click Internet Options.

3 On the Internet Options dialog box, click the Security tab, and then 
click the Custom Level button.

4 On the Security Settings dialog box, scroll to Downloads, click to select 
the Enable button for the following, and then click OK

- File download
- Font download
- Automatic prompting for file downloads.

5 On the Internet Options dialog box, click OK.
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The following diagram shows the Internet Options dialog box. The arrow 
points to the Custom Level button.

The following diagram shows the Security Settings dialog box. The arrow 
points to the Downloads options.
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To download Acrobat Reader X

You may already have Acrobat Reader X installed on your personal computer! 
If so, you do not need to perform this task! You must have Administrator rights 
to install Acrobat Reader X on to your personal computer.

1 Start your Internet browser, and then type the following address in the 
Address bar:

http://www.adobe.com

2 Under Downloads click Adobe Reader.

3 On the Adobe Reader page, click the Download now button.

4 Complete the installation as instructed on the 

The following diagram shows the Adobe.com main web page. The arrow 
points to the Adobe Reader download.
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The following diagram shows the Acrobat Reader page. The arrow points to 
the Download now button.

The following diagram shows the Adobe Reader page that lists the 
instructions for downloading and installing Acrobat Reader X on to your 
personal computer.
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Organizing your reports
This section explains how to perform the following:

• view available Cognos reports by list or by details
• create a new folder in My Folders
• move a report to another folder in My Folders
• change the order of the report listing in My Folders
• bookmark a report.

To view report details along with report name

The initial setting for the Portal-Default view is “List.” Select the “List” option to 
view a list of available reports. Select the “Details” option to view available 
reports along with brief descriptions.

1 On the IBM Cognos Connection toolbar, click the My Area drop-down 
arrow, and then click My Preferences.

2 Under Default view, click Details.

3 Click OK.

The following diagram shows IBM Cognos Connection toolbar. The arrow 
points to the location of the My Area drop-down arrow and menu options.

The following diagram shows the Set preferences screen. The arrow points to 
the Details option under Default view.
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The following diagram shows a detail view of reports available in the User 
Community Reports folder.

To create a new folder for organizing your reports

1 On the IBM Cognos Connection toolbar, click the New Folder button.

2 On the New Folder Wizard screen, complete the following text boxes

- Name

- Description

- Screen tip.

3 If not already selected, click My Folders, and then click the Finish 
button.

The following diagram shows the New Folder Wizard screen.

To move a report to a different folder

1 Click the More link that corresponds to the report of your choice.

2 On the Perform an action screen, click the Move button or the Move 
link.

3 On the Select a location screen, click to select the folder of your choice, 
and then click OK.
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The following diagram shows the Select a location screen.

To change the order of your report listing

1 In My Folders, click the Order button on the IBM Cognos Connection 
toolbar.

2 On the Order folders and entries screen under Folders-Shown in 
default order, click to select one or more folder(s) that you want to 
change the order of, and then click the Add button.

Each folder is added to the bottom of the Shown first column.

3 Under Entries-Shown in default order, click to select one or more 
reports(s) that you want to change the order of, and then click the Add 
button.

4 Continue to click the following buttons to change the order of folders and 
entries as desired, and then click OK

- Add
- Remove
- Add all
- Remove all.

The following diagram shows the Order folders and entries screen.
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To bookmark a report (add to your Favorites in Internet Explorer)

1 Run the report of your choice.

2 On the Cognos Viewer toolbar, click the Add this report drop-down 
arrow, and then click Add to My Bookmarks.

3 On the Add a Favorite dialog box, type the name of the bookmark, as 
appropriate, and then click Add.

The following diagram shows the Add a Favorite dialog box. 

Working with Standard reports
This section explains tasks specific to working with Standard reports that are 
available in ROSS. Topics include:

• Completing filter criteria for Standard reports
• Running Standard reports.

For more information about scheduling a Report View see, “Scheduling a 
Report View,” later in this chapter.

To access Standard reports

1 On the Administration menu, click Reports.

2 From the IBM Cognos Connection screen on the Public Folders tab, 
click to select one of the following folders of your choice

- Administration
- Incident
- Status.

The following diagram shows the IBM Cognos Connection screen. The 
arrows point to the Administration, Incident, and Status folders.
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Completing filter criteria for Standard reports
A filter criteria screen displays when you run a report. This screen is specific 
to the report and usually contains both required and optional fields from 
which you may select. A red dashed line identifies a required field that has yet 
to be selected.

To complete filter criteria for a Standard report

1 On the filter criteria screen that displays for the report of your choice, 
click ( ) to open the filter options.

Filter options may already be opened for entry.

2 For each required field, click to select the filter criteria of your choice, 
and then click the Filter button.

The Filter button allows you to restrict (or filter) the ROSS data that will be 
accessed to run your report. 

3 When finished selecting all required fields, click the View Report button.

To clear filter criteria

1 To clear all filters on the filter criteria screen, click the Clear Filters 
button on the filter criteria screen.

2 To clear individual filter criteria, click to select the Clear Filter option 
that corresponds to the filter criteria of your choice.
October 27, 2011 version 2.14 13



ROSS User’s Guide Reports - running and scheduling reports
The following diagram shows a portion of the filter criteria screen for Incident 
Resource List. The arrows point to the Clear Filter options for Catalog filter 
criteria.

Running Standard reports
This section explains how to run a Standard report and save it as a Report 
View in My Folders in Cognos. This section also explains how to change the 
format of the report

For more information about scheduling a Report View see, Scheduling a 
Report View,” later in this chapter.

To run a Standard Report and save it as a Report View

1 On the Administration menu, click Reports.

2 From the IBM Cognos Connection screen on the Public Folders tab, 
click to select one of the following folders of your choice

- Administration
- Incident
- Status.

3 On the filter criteria screen that displays for the report of your choice, 
click ( ) to open the filter options.

Filter options may already be opened for entry.
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4 For each required field, click to select the filter criteria of your choice, 
and then click the Filter button.

The Filter button allows you to restrict (or filter) the ROSS data that will be 
accessed to run your report. 

5 When finished selecting all required fields, click the View Report button.

6 Click the Keep this version drop-down arrow, and then click to select 
Save as Report View.

7 On the Save as report view screen, type the name of the report in the 
Name text box.

8 Under Location, verify or click to select My Folders, and then click OK.

The following diagram shows a sample filter criteria screen for an Incident 
Resource List report. The arrow points to the Incident () option and identifies 
the required filter criteria. You must click to open and then complete all 
required filter criteria to run the report.
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The following diagram shows the resulting Incident Report List report. The 
arrow points to the Keep this version drop-down arrow.

The following diagram shows a sample Save as report view screen for a 
Standard report.

To run a Standard report saved in My Folders

• On the My Folders tab, click the report name of your choice.
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The following diagram shows a sample report displayed on the Cognos 
Viewer.

To change filter criteria for a Standard report saved as a Report 
View in My Folders in Cognos

1 On the My Folders tab, click the Run with options button that 
corresponds to the report name of your choice.

2 On the Run with options screen, click to select the Prompt for values 
check box.

The Prompt with values check box may already be selected.

3 On the filter criteria screen that displays for the report of your choice, 
click ( ) to open the filter options.

Filter options may already be opened for entry.

4 For each required field, click to select the filter criteria of your choice, 
and then click the Filter button.

5 When finished selecting all required fields, click the View Report button.
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The following diagram shows the Run with options screen. The arrow points 
to the Prompt for values check box.

Working with User Community reports
This section explains tasks specific to running User Community reports that 
are available in ROSS. Topics include:

• Entering prompt values and running a User Community report
• Saving the Report View to My Folders in Cognos.

For more information about scheduling a Report View see, Scheduling a 
Report View,” later in this chapter.

To access User Community Reports

1 On the Administration menu, click Reports.

2 From the IBM Cognos Connection screen on the Public Folders tab, 
click to select the User Community Reports folder.

The following diagram shows the Public Folders tab, Details View, in 
Cognos. The arrow points to User Community reports.
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The following diagram shows the User Community Reports screen. The 
arrow points to the location of these reports in Cognos.

The following diagram shows the reports available from the UC - Incidents 
folder. The arrows highlight the HTML icons next to each report name, which 
tells you that the default format for running that User Community Report is 
HTML.

Entering prompt values and running a User Community report
This section explains how to enter prompt values for a sample User 
Community report and run the report using current data. 

The default format for User Community reports is HTML.
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To enter prompt values for a User Community report

Required values display a red asterisk (*) next to its name. 

1 On the Prompt screen that displays for your User Community report, 
click to select the first set of values in the Provide a value list box, and 
then click the Reprompt button.

To select more than one value at a time, click and hold [CTRL], and then 
click to select the values of your choice.

2 Click to select the next set of values, clicking the Reprompt button after 
each selection.

3 When finished, click OK.

The following diagram shows a sample, completed Prompt screen for the 
Incident List by GACC and Dispatch.
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The following diagram shows the resulting Incident List by GACC and 
Dispatch report, based on these prompt values.

To change prompt values for your report

1 While viewing the User Community report of your choice, click the Run 
button on the Cognos Viewer toolbar.

2 Complete the required prompt values as appropriate, and then click OK.

The following diagram shows the Cognos Viewer toolbar. The arrow points to 
location of the Run button.

Saving a User Community Report View to My Folders in Cognos
Once you complete all required prompt values, you can save the Report View 
to My Folders in Cognos and run it as needed to obtain the most current data.

To save a User Community report as a Report View to My Folders 
in Cognos

1 Click to select the User Community report of your choice.

2 Complete the required prompt values, and then click OK.
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3 Click the Keep this version drop-down arrow, and then click to select 
Save as Report View.

4 On the Save as report view screen, type the name of the report in the 
Name text box.

5 Under Location, verify or click to select My Folders, and then click OK.

6 To view the saved Report View, click the Home button, and then click 
the My Folders tab.

The following diagram shows the Save as report view screen for an Incident 
List by GACC and Dispatch report. The arrow points to My Folders.

The following diagram shows the resulting Report View saved in My Folders.

To run a Report View from My Folders in Cognos

1 On the IBM Cognos Connection toolbar, click the My Folders tab.

2 On the My Folders tab, click the Run with options button for that 
Report View.

3 On the Run with options screen, click the Format drop-down arrow, and 
then click to select the report format of your choice.

To accept the default format (HTML) for the User Community report, you 
may skip this step!

4 Under Delivery, click to select View the report now.

5 If not already selected, click to select the Prompt for values check box.

6 Click the Run button.
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7 On the Prompt screen, click to select the report values of your choice, 
and then click OK.

8 Click to select all required values for each list box, clicking the 
Reprompt button after each selection.

Required values display a red asterisk (*) next to its name. 

9 When finished selecting all required values, click OK.

10 On the File Download dialog box, click Save.

11 On the Save As dialog box, complete the File Name, and then save the 
report to your personal computer in the location of your choice.

The following diagram shows a sample My Folders. The arrow points to the 
Run with options button for the Report View of CO-RMC Incident List by 
GACC, Dispatch.

The following diagram shows the Run with options screen. The arrows point 
to the Format drop-down arrow and then View the report now option. In this 
example, the report will be generated in Delimited text (CSV) format.
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The following diagram shows the resulting File Download dialog box for 
saving the generated report as Delimited text (CSV).

The following diagram shows a sample Save As dialog box for saving a CSV 
file to your desktop.

Scheduling a Report View
This section explains how to schedule a Report View from My Folders. 
Whether the Report View is a Standard report or a User Community report, 
scheduling a Report View is performed in the same way. You have the 
following options for scheduling a Report View:

• By Day
• By Week
• By Month
• By Year
• By Trigger.

Before scheduling your reports determine how often you realistically need the 
report to run. Remember that scheduling a report to run too frequently ties up 
the system, which impacts all others trying to run their reports. 

Running the report as you need it may be more appropriate if you need the 
report frequently throughout the day.
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To schedule a single report to run on a regular basis

1 Run the User Community report of your choice, and then save it to My 
Folders in Cognos.

2 Click the My Folders tab, and then click the Schedule button that 
corresponds to the report of your choice.

3 On the Schedule screen, click to select the Frequency tab of your choice.

4 Under Prompt values, click to select the Override default values check 
box, and then click the Set link.

5 On the Prompt screen, complete the value(s) for the report of your 
choice, and then click OK.

6 On the Schedule screen that displays for the Frequency tab you selected, 
complete the information as appropriate, and then click OK.

The following diagram shows a sample My Folders. The arrow points to the 
Schedule button for the Report View of CO-RMC Incident List by GACC, 
Dispatch.

The following diagram shows a sample Schedule screen. The arrows point to 
Frequency and Prompt values. In this example, the report is being scheduled 
every Monday.
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The following diagram shows the resulting Schedule screen.

To edit a schedule

1 On the My Folders tab, click the Schedule link that corresponds to the 
report of your choice.

2 On the Schedule screen, change the information as appropriate for that 
screen and your needs, and then click OK.

To disable a schedule

1 On the My Folders tab, click the Schedule link that corresponds to the 
report of your choice.

2 On the Schedule screen, click to select the Disable the schedule check 
box, and then click OK.

To schedule multiple reports to run on a regular basis

Saved schedules appear on your My Folders tab.

1 On the IBM Cognos Connection, click the New job button.

2 On the New job wizard screen, complete the following information

- Name
- Description
- Screen tip.

3 Click the Select My Folders link, and then click the Next button.

4 On the New job wizard screen, click the Add link.
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5 On the New job wizard screen, click to select the check boxes that 
correspond to the reports you want to schedule, and then click the Add 
arrow button.

6 If appropriate, navigate to the Public Folders and add all the reports you 
want to schedule. 

For more information about navigating to the ROSS Public Folders see 
the task, “To navigate to a different folder,” in this section.

7 When finished adding all the reports you want to schedule, click OK.

8 On the New job wizard screen, click to select the check boxes that 
correspond to the reports you want to schedule, set the options and 
prompt values for each report as appropriate.

9 Under Submission of steps, click to select the option of your choice, and 
then click the Next button.

10 On the Select an action - job screen, click to select Save and schedule, 
and then click the Finish button.

11 On the Schedule screen, click to select one of the following tabs

- By Day
- By Week
- By Month
- By Year.

12 On the Schedule screen that displays for the tab you selected, complete 
the information as appropriate for that screen and your needs, and then 
click OK.

For complete information about completing the Schedule screen see the 
next tasks, “To schedule daily reports,” “To schedule weekly reports,” “To 
schedule monthly reports,” and “To schedule yearly reports,” in this 
chapter.
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The following diagram shows a sample My Folders screen. The arrow points 
to the New Job button.

The following diagram shows the New job wizard screen for naming the 
reports in your schedule.
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The following diagram shows a sample New job wizard screen showing a list 
of reports to be scheduled. In this example, reports being scheduled are from 
the Public Folders/ROSS/Incident folder.

The following diagram shows the Select the steps screen.
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The following diagram shows the Select an action - job screen. The arrow 
points to the Save and schedule option.

The following diagram shows a sample Run with options - Multiple 
Scheduled Reports screen.

To email a scheduled report

1 On the My Folders tab, click the Run with options button that 
corresponds to the report of your choice, and then click the advanced 
options link.

2 On the Run with advanced options screen under Delivery, click to select 
the Send a link to the report by email check box, and then click to select 
the Edit the options link.

3 On the Set the email options screen, complete the following information 
as appropriate and then click OK

- To

- Cc

- Subject

- Body.

Separate email addresses using a semi-colon and no spaces. Use the 
sample format:
name1@service provider1.com;name2@service provider2.gov; and so 
on.

4 On the Run with advanced options screen, complete the remaining 
information as appropriate, and then click the Run button.
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The following diagram shows the Run with advanced options screen. The 
arrow points to the Send a link to the report by email check box.

The following diagram shows a sample Set the email options screen.

Due to restricted access to Cognos folders and to secure network 
connections, the Include a link to the report check box is disabled.

To email scheduled multiple reports

To print multiple reports that are scheduled, you must first save it to your 
personal computer.

1 On the My Folders tab, click the Set properties button that corresponds 
to the scheduled group of reports of your choice.

2 On the Set properties screen, click the Job tab.
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3 On the Job tab under Default for all steps, click to select the Set link.

4 On the Select default options screen, click to select the Report options 
link, and then click to select the Specify default values for all the 
reports of this job check box.

5 Under Delivery, click to select the Save the report, print it, or send an 
email option, click to select the Send the report by email check box, and 
then click to select the Edit the email options link.

6 On the Set the email options screen, complete the following information 
as appropriate and then click OK 

- To
- Cc
- Subject
- Body.

Separate email addresses using a semicolon and no spaces. Use the 
sample format:
name1@service provider1.com;name2@service provider2.gov; and so 
on.

7 On the Set the email options screen, complete the following information 
as appropriate and then click OK

- To
- Cc
- Subject
- Body.

Separate email addresses using a semicolon and no spaces. Use the 
sample format:
name1@service provider1.com;name2@service provider2.gov; and so 
on.

The following diagram shows the Set properties screen. The arrow points to 
the Set link on the Job tab.
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The following diagram shows the Select default options screen. The arrow 
points to the Report options link.

The following diagram shows the Select default options screen. The arrows 
point to the Specify default values for all the reports of this job check box and 
the Send the report by email check box.

To save a report in another format of your choice

You can change the format of Report View, which was previously saved in My 
Folders in Cognos, to run in another format.

1 Create a Report View of the Standard or User Community report of 
your choice and save it in My Folders in Cognos.

2 Click the My Folders tab, and then click the Run with options button for 
that Report View.

3 On the Run with options screen, click the Format drop-down arrow, and 
then click to select the report format of your choice.

4 Under Delivery, click to select View the report now.

5 If not already selected, click to select the Prompt for values check box.

6 Click the Run button.

7 On the Prompt screen, click to select the report values of your choice, 
and then click OK.
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Saving a report to your personal computer
This section explains how to save a report and its snapshot of data in a format 
of your choice to your personal computer.

For more information about using Citrix to access ROSS and how to save that 
report to the Citrix farm or a network drive see, “Using Citrix to access ROSS,” 
later in this chapter.

To save a report to your personal computer in PDF

1 Run the Standard or User Community report of your choice, in the 
format of your choice.

2 Click the Save a copy button.

3 On the Save as dialog box, name the file and save it to a location of your 
choice.

The following diagram shows a sample Incident List Report in PDF format. 
The arrow points to the location of the Save a copy button.
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The following diagram shows a sample Save as dialog box.

Printing and emailing a report
Once you have the report saved in the format of your choice, you can use the 
appropriate application software to perform a wide variety of tasks, including 
the following:

• open the report
• print the report
• email the report.

To find out more about opening and printing reports saved to your personal 
computer, please refer to the application software user documentation for 
more information.

Using Citrix to access ROSS
This section explains tasks for using Citrix® to connect to and access ROSS 
from any Internet connection. From Citrix, you will notice that ROSS 
responds faster with quicker querying capabilities. Topics include:

• Getting started with Citrix

• Working with User Community reports when using Citrix.

Be sure to use the Internet address appropriate for your agency. If you are 
having trouble logging in for the first time see the task, “To manually install the 
Citrix plug-in onto your laptop or personal computer,” later in this section.
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Getting started with Citrix
This section explains how to set up your personal computer so that you may 
effectively use Citrix and ROSS Reports.

To setup drive access for an individual ROSS user’s computer

Perform this task before attempting to save ROSS reports to your desktop for 
the first time!

1 In WordPad or NotePad, type the following text

[Access]

GlobalSecurityAccess=405

2 Save the file as ASCII text in the following folder on your personal 
computer

C:\Documents and Settings\<username>\Application 
Data\ICAClient\webica.ini.

The following diagram shows a WordPad screen for the webica.ini file.

To log on to ROSS using Citrix - for FS users only

1 Start your Internet browser, and then type the following address in the 
Address bar:

https://apps.fs.fed.us/Citrix
36 version 2.14 October 27, 2011



Reports - running and scheduling reports ROSS User’s Guide
2 On the Enterprise Production Data Center at Kansas City (Citrix) 
screen under Login, complete the following information, and then click 
the Log In button

- Active Directory user name
- Active Directory password.

The Domain Name should read, “DS,” on the Citrix Web Interface Login 
screen.

3 On the Applications page, navigate to the \National Applications\ 
ROSS folder, and then click the ROSS icon of your choice.

4 On the ROSSHome screen, click Yes, and then log in as usual using your 
ROSS username and ROSS password.

The following diagram shows the Enterprise Production Data Center at 
Kansas City (Citrix) screen. The arrow points to the Domain Name, “DS,” 
which tells you that you are accessing the Citrix farm from a Forest Service 
computer
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The following diagram shows the \National Applications folder. The arrow 
points to the ROSS folder.

The following diagram shows the /National Applications\ROSS folder. The 
arrow points to the ROSS 2_14 icon.

If you are having trouble logging in for the first time see the task, “To 
manually install the Citrix plug-in onto your laptop or personal computer,” 
in this section.

To log on to ROSS using Citrix - for non-FS users only

1 Start your Internet browser, and then type the following address in the 
Address bar:

https://ross.fs.fed.us/Citrix
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2 On the Citrix Web Interface Login screen under Login, complete the 
following information and then click the Log In button

- Active Directory user name

- Active Directory password.

The Domain Name should read, “ROSS,” on the Citrix Web Interface 
Login screen.

3 On the Citrix Web Interface Applications screen, click the ROSS 2_14 
coffee cup icon.

If you are having trouble logging in for the first time see the task, “To 
manually install the Citrix plug-in onto your laptop or personal computer,” 
later in this section.

4 On the ROSSHome screen, click Yes.

5 Log in as usual, using your ROSS username and ROSS password.

The following diagram shows the Citrix Web Interface page. The arrow points 
to the Domain Name, “ROSS,” which tells you that you are accessing the 
Citrix farm from a non-Forest Service computer.

The following diagram shows the Citrix Web Interface Applications screen, 
The arrow points to the ROSS 2_14 coffee cup icon.
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To exit Cognos Reports, ROSS, and the Citrix server

Be sure to exit ROSS before logging off the Citrix server!

1 On the IBM Cognos Connection toolbar, click the Log On link, click to 
select Log Off, and then close the Cognos browser window.

2 In ROSS, click Exit ROSS on the File menu, and then click Yes.

3 On the Enterprise Production Data Center at Kansas City (Citrix) or 
Citrix Web Interface Applications screen, click the Log Off button.

4 Close your Internet browser.

The following diagram shows the location of the Log On link. The arrow 
points to the Log Off option.

To manually install the Citrix plug-in onto your laptop or personal 
computer

If you are unable to connect to Citrix, you may need to open and install the 
Citrix plug-in onto your laptop or personal computer. You will need 
Administrator rights to install.

1 Start your Internet browser and then type the following in the address bar

- http://www.citrix.com

2 On the Citrix screen, click Downloads.

3 On the The downloads you need in one, easy place screen, click the 
search Downloads by Product drop-down arrow, and then click to select 
XenApp.

4 On the Find all downloads you need-fast screen, scroll to the bottom of 
the page.

5 Under Legacy Clients, click the Online Plug-In 12.1.144 for Windows 
Internet Explorer 8 Support download link.
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6 On the Online Plug-In 12.1.144 for Windows Internet Explorer 8 
Support screen, click the Download button to download Citrix Online 
Plugin - Web.

7 On the Download Manager dialog box, click the Download your file 
manually link.

8 On the File Download dialog box, click the Save button, and then save 
CitrixOnlinePluginWeb.exe to your desktop.

9 On your desktop, double-click the CitrixOnlinePluginWeb.exe icon, and 
then complete the installation as instructed on your screen.

The following diagram shows the Citrix screen. The arrows point to 
Downloads and the XenApp option on the Search Downloads by Product 
drop-down menu.
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The following diagram shows the bottom of the downloads page   The arrow 
points to the Online Plug-In 12.1.144 for Windows Internet Explorer 8 
Support download link.

The following diagram shows the Online Plug-In 12.1.144 for Windows 
Internet Explorer 8 Support screen. The arrow points to the Download button 
to download the Citrix Online Plugin - Web file.
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The following diagram shows the Download Manager dialog box. The arrow 
points to the Download your file manually link.

The following diagram shows the File Download dialog box.

Working with User Community reports when using Citrix
If you wish to print a User Community report and are using Citrix to access 
ROSS, you must first save it to one of the following network drives:

• For Forest Service users. Save your User Community reports to the 
Citrix farm, which is located in: on ‘ds.fs.fed.us\Efs’(T:)/DataCenter/
citrix/home/your Lotus shortname/My Documents. To quickly locate 
these files, you can create a folder in the Citrix farm for your reports and 
then save it as shortcut to your desktop.
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• For non-Forest Service users. Save your User Community reports to C$ 
on Clint (V:)/Documents and Settings/your login folder/Desktop.

User Community reports saved in the Citrix farm contain data from a single 
point in time. To obtain the most current data, save the User Community 
report view to “My Folders in Cognos, schedule it to run as needed, and then 
email it to yourself. From your ISP you can print that report as needed.

Saving and printing User Community reports when using Citrix - for FS users only

This section explains to save and print User Community reports when using 
Citrix to access ROSS from a Forest Service computer.

To create a shortcut to the Citrix farm

1 In Windows Explorer, click My Computer, and then click the 
on ‘ds.fs.fed.us\Efs’(T:) drive.

2 On the on ‘ds.fs.fed.us\Efs’(T:) drive, click the DataCenter folder, click 
the citrix folder, and then click the Home folder.

3 In the Home folder, click the your DS user name folder, and then click 
the My Documents folder.

Your DS user name is your log in User name when you log onto your FS 
computer. For example, John Doe would click his DS user name folder, 
“jdoe.”

4 In the My Documents folder, right-click and point to New, click Folder, 
and then name the new folder with a name of your choice.

In this example this new folder is named, “ROSS Reports.”

5 Right-click the folder you just created, point to Send To, and then click 
Desktop (create shortcut).
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The following diagram shows the DataCenter folder on the on 
‘ds.fs.fed.us\Efs’(T:) drive in Windows Explorer.

The following diagram shows the location of the “ad.jdoe” folder (your Lotus 
shortname folder) in on ‘ds.fs.fed.us\Efs’(T:)/DataCenter/citrix/home.
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The following document shows the menu for creating a new folder in your 
“My Documents” folder.

The following diagram shows the menu for creating a shortcut to a sample 
new folder, “ROSS Reports,” to your desktop.
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To save a User Community report in another format of your 
choice using Citrix to access ROSS

1 Create a Report View of the User Community report of your choice and 
save it in My Folders in Cognos.

2 Click the My Folders tab, and then click the Run with options button for 
that Report View.

3 On the Run with options screen, click the Format drop-down arrow, and 
then click to select the report format of your choice.

4 Under Delivery, click to select View the report now.

5 If not already selected, click to select the Prompt for values check box.

6 Click the Run button.

7 On the Prompt screen, click to select the report values of your choice, 
and then click OK.

8 On the File Download dialog box, click Open.

You must first click Open before saving the report to your Citrix farm 
shortcut. Do not click Save! If a warning/error message displays after 
clicking Open, click Yes to Open the file now.

9 Once the report opens in the appropriate software for that report’s file 
extension, save it to the Citrix farm.
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The following diagram shows the My Folders tab. The arrow points to the 
Run with options button for the Report View of Incident List by GACC, 
Dispatch.

The following diagram shows the Run with options screen. The arrows point 
to the View this report now option and the 
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The following diagram shows a sample Prompt screen for the Incident List by 
GACC, Dispatch report.

The following diagram shows the File Download dialog box. The arrow 
points to the Open button.
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The following diagram shows a sample report saved as .CSV and opened in 
Microsoft Excel. The arrow points to the Save As option in Excel.

The following diagram shows a sample Save As dialog box for saving a report 
to your Citrix farm.

To access a saved User Community report when using Citrix

Remember, to obtain current data for the report you must rerun the Report 
View from My Folders in Cognos and then save it again to the Citrix farm! For 
more information see, “To save your User Community report view to My 
Folders,” in the section, “Running, saving, scheduling, and printing User 
Community reports,” earlier in this ROSS User’s Guide.

• From your Desktop, locate and click to open the shortcut to the Citrix 
farm, and then open the User Community report of your choice.
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To print a saved User Community report when using Citrix to 
access ROSS

1 From your Desktop, locate and click to open the shortcut to the Citrix 
farm, and then open the User Community report of your choice.

2 Adjust the layout of the report as needed, and then click Print using the 
software you used to open the saved report.

3 Complete the Print dialog box as appropriate.

For more information about creating this shortcut see, “To create a 
shortcut to the Citrix farm,” earlier in this section.

Saving and printing User Community reports when using Citrix - for non-FS users only

This section explains to save and print User Community reports when using 
Citrix to access ROSS from a non-Forest Service computer.

Non-FS users must have an Active Directory account to use Citrix. For more 
information contact the ROSS Citrix coordinator for your geographic area.

To access a saved User Community report when using Citrix

1 From Windows Explorer, navigate to the following folder

C$ on Clint (V:)/Documents and Settings/your login folder/Desktop.

2 Locate and then click to open the User Community report of your 
choice.

To save a User Community report when using Citrix to access 
ROSS

While using Citrix, you must first save any User Community reports to your 
desktop before you can view or print!  

1 Create the User Community report of your choice.

2 On the Cognos Viewer toolbar, click the View in PDF format 
drop-down arrow, and then click to select the View in... of your choice.

In this example, the report is saved in .CSV format.

3 On the File download dialog box, click OK.

4 On the Save As dialog box, click the Save in drop-down arrow, and then 
click to select C$ on Client (V:).

5 Double-click the Documents and Settings folder, and then double-click 
your login folder.

For example, the login folder for John Doe might be named “jdoe.”
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6 In your login folder, double-click the Desktop folder.

7 Navigate to the folder of your choice, and then click Save.

8 On the Download complete dialog box, click Close.

The following diagram shows the File download dialog box.

The following diagram shows the Save As dialog box for saving a report on 
the C$ on Client (V:) drive.

To print a saved User Community report when using Citrix to 
access ROSS

To print, you must close the report and then open it from your personal 
computer. You can not print from Citrix!

1 From Windows Explorer, navigate to the following folder

C$ on Clint (V:)/Documents and Settings/your login folder/Desktop.
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2 Locate and then click to open the User Community report of your 
choice.

3 Adjust the layout of the report as needed, and then click Print using the 
software you used to open the saved report.

4 Complete the Print dialog box as appropriate.
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